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SECTION 1: SETUP AND BASIC OPERATION

1.1 Introduction

	Welcome to the Newage® Instruments Computer-Assisted Measurement System Program, a Windows™-based image 
acquisition and measurement software for B.O.S.S.® (Brinell Optical scanning System).  This software was developed to 
enhance the capabilities of your hardness testers by allowing you to automate the measurement of test impressions, reduce 
operator influence on test    results, and transfer test results directly to a PC for real time, on-screen data management.

	It is assumed that the operator has a basic understanding of Windows.  If you are unfamiliar with how to use a PC, please 
refer to your Windows manual for instructions.

	The B.O.S.S. computer program is file based.  All setup parameters 
(such as hardness scale, tolerance limits, part information, etc.) are saved 
with the individual file they are associated with.

1.2 What’s Included

	The complete package consists of :
			  1 - Brinell scan head (see detail at right)
            (regular "Lab Boss", or small nose "Lab Small") 

		 1 - CD or flash drive with BOSS software and drivers
			  1 - Operation Manual
			 

1.3 System Requirements

	Computer:  Windows XP or Windows 7 and USB-2 port

1.4 Principles of Operation

The B.O.S.S. System uses a scanning head attached to a computer to measure Brinell impression widths.   The 
B.O.S.S.‑ System is for accurate impression measurement, and data storage/printing only.  It does not perform any 
tests by itself.  Operation of the hardness tester remains as described in it’s own operation manual.  Please refer to it 
for tester setup and operation.

The B.O.S.S. can be used in either manual or automatic mode.  The Brinell 	impression is measured in both axes and 
the value averaged and converted to a hardness value.  The accuracy is affected by the surface condition of the test 
specimen.  Too rough a surface will cause the tester  to report the reading is not good due to the surface condition.

"Lab Small" style
without removable

base

"Lab Small" style 
with removable 

base

Standard 
"Lab Boss" style
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1.5 Lab B.O.S.S. Installation, Software, if required

Instructions for software installation, if necessary, on included media. See ReadMe. rtf file.
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1.6 Initial Software Startup
Setup automatically sets magnification to be Lab BOSS

1) Double click the icon to start the program. 

2) The program will open up to the last file that  was in use.  If no data files have been created,  the operator can 
create a new file.   (See Sec 2.1.1 Create a New File)  Hardness test results will be added to the database of the 
current open file.

FOR SMALL-NOSE SCAN HEAD BOSS:
If the unit has a small nose scan head (LAB SMALL), the objective must be changed in the Update Dialog Box from
Lab BOSS to Lab Small. Please refer to section 3.3.1 for details.

HD UNITS:
Do not select "HD BOSS" under magnification.
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1.7 Procedures for a Test Measurement

1.7.1 For Automatic Measurement 

	(Operator should also refer to following 
sections for setting up new files)
	Use your Brinell tester to perform a 
test and create a test impression.   
When you move the BOSS head into 
position over the sample, the image 
of the impression should appear on 
the monitor.  Click on the Measure 
button on the right side of the 
computer screen or click the button 
on the scan head.  The indicators 
defining the indentation edge will 
appear.  If they are correctly placed, 
accept the reading by clicking on the 
Accept button.  The reading will be 
displayed with the scale designation 
on the top left corner and, if 
selected, the value converted to an 
alternate scale.  If the automatic 
positioning of the indicators is not 
accurate the operator can click the 
right  mouse button (with the cursor 
inside the image area) to clear the 
measurement indicators and restore a 
live image, reposition the BOSS head 
and press the measure button again 
or perform a manual measurement.  
(See below.) Press the Accept button 
to complete the test.  To see the test 
recent measurement results, select 
the View menu option(s) from the 
main menu bar.

1.7.2 For Manual 
Measurement

	After a test has been made with the 
tester and the image to be measured is 
displayed on the monitor,  the lines can 
be manually positioned without using the Measure Button.  The operator must make a judgement as to the 
location of the edges of the impression and click the mouse at the top, bottom, right and left.   The small X 
mark on the center of the screen must fall within the area of the impression to be measured.  Otherwise the 
operator must use the forced positioning arrows near the top right of the screen.  After the first line has been 
placed, the image freezes on the screen.  After positioning lines on the sides as well as the top and bottom, 
accept the reading or click the right mouse button to return to the live image.   To see the data select the View 
menu option(s) from the main menu bar. 

Manual Measurement

Automatic Measurement
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SECTION 2: FILE FUNCTIONS

The Main Menu Bar at the top of the screen contains 5 selections: File, View, Setup,  Data, and Help. They can be 
accessed with the mouse by  clicking on  the selection.  Click on one of them to open up it’s individual menu.  The File 
Menu  consists of 7 different functions: New, Open, Close, Print, Print Preview, Print Setup, and Exit, as well as a listing of 
the last 4 files that have been in use.

2.1 Create a New File

1) Select New from the File Menu.  The Create a New Test File dialog box will appear.

2) Type in the name of the file (8 characters maximum) using the .csv extension and select the OK button (or press 
Enter.)

3) You are prompted for what set of parameters to use.  You can select USE‑CURRENT‑PARAMETERS to enter the 
file parameters from the most recently used file; you are then prompted for a new comment.  If you select to 
ENTER‑NEW‑ PARAMETERS you can set up a completely new set of parameters.  (See Following Section.)  
Finally, you can select to Retrieve  Parameters. (Optional - appears grayed out when not activated.) When 
activated you are prompted to enter the file name from which to retrieve the parameters.  You are able to enter a 
new comment for this selection also.  

4) The next dialog box requires you to Select a New Scale.  Choose one of the Primary Scales listed on the left by 
highlighting it with the mouse.   If you would like the test result automatically converted to another scale, highlight 
one of the Converted Scales listed on the right .  
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You will then be prompted for Data Part File Information.  This information can be used to keep track of Part Number, 	
Description, Order Number, Comments, etc., related to this file.  These headings will appear on printouts.  Data entry 
is not required.  Select OK when done.

	Clicking on the checkbox for “Prompted” will cause this window to appear after each test so the operator can enter relevant 
data.  Selecting "Sort by Prompt" will sort data in the printouts by the prompts so commented data can be readily identified.

	Note: You may create custom headings by selecting the Field Names button, highlighting the name you wish to change, 
and typing in the new heading.  To make the new headings you’ve typed the default headings for all new files you 
create, select Change Defaults.  Use Defaults will revert headings you’ve just typed to the current default headings.
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The  scale abbreviations  which may be listed are:

		 HB = Brinell Scale for BOSS
		 DIA =  Diameter Measurement  for BOSS
		 INCH = Measurement in Inches 
		       	for linear measurement
		 MM = Measurement in Millimeters 
		    	for linear measurement
		 HRC = Rockwell C scale
		 HV = Vickers Scale for use with B.O.S.S. 
		 HK = Knoop Scale for use with B.O.S.S.
		 HRB = Rockwell B scale
		 HRA = Rockwell A scale
         HR15N, 30N, 45N = Rockwell N scales
         HR15T, 30T, 45T = Rockwell T scales
         HRD = Rockwell D scales
         HRE = Rockwell E scales
			 
Select OK when done. 

NOTE:  The scale cannot be changed for a data file that contains test results.  The operator will be prompted to 
change files if he tries to change scales with data in the file

5) After selecting the scale you will be prompted for 
Average Mode.  The operator may select to record 
averages of multiple tests rather than the individual 
tests.  Enter a value into the Group Size.   The radio 
buttons on the remaining box are enabled.  The 
selections are as follows:

Keep All	  	

The default setting.  Returns the Average Mode to 
the standard mode

Eliminate Highest and Lowest Values

When 3 or more tests are selected to be averaged 
the system will remove the highest and lowest 
values from the group average.  For example, if the 
average is set for 5, then 3 results will go into the 
average.  If an average of 2 is selected the average function has no effect.

Eliminate furthest from the average

Once the testing is completed the system calculates the average and removes the one test that is furthest from that 
average.  If an average of 2 is selected the average function has no effect

Eliminate if standard deviation exceeds [selection]

The operator is prompted to enter a maximum standard deviation value.  When the testing is done the value farthest from 
the standard deviation allowable is removed.  If all the values fall within the standard deviation then none are removed.

6) After selecting the scale, you will be prompted to Set Tolerances.  The program uses these settings for statistical 
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calculations and for HI, LO, and OK indications for individual test results.  
When the Advanced Statistics Option has been purchased the X-Bar/R 
Chart uses these settings to plot the “high” and “low” test results as red 
points on the graph; “acceptable” test results are plotted as green points.  
You may also set a low warning and high warning number - those test 
results are indicated by a gray color on the Advanced statistics output.  
The “Warning” test results do not affect statistical calculations.  

Select the desired button, key in the hardness value, and select OK when 
done.  Repeat this sequence for tolerance setting.  

When the Acknowledgment Required box is checked  the operator will 
have to acknowledge every time an out-of-tolerance result is produced.  
The operator can also enter the default error-checking value to limit the 
relative size of the two axes on the Vickers scale.

Operators may also adjust the default tolerance setting that controls the 
allowable difference between the two Vickers axis widths.  Any value may 
be entered.

NOTE: Entering or leaving the values of zero will deactivate the Tolerance 
function.  All readings will then be assigned OK status.

After setting the tolerance values, select OK to proceed.  

7) Next the operator is given a chance to update the test parameters: 
load and camera objective.  It is important to select the proper parameters 
for the scale that the test was performed in on the hardness tester.  
Otherwise the final measured test result will be incorrect.

To change the default values, click on the arrows with your mouse.  A 
selection of all the possible values will appear.  For each scale the operator 
has selected the available selections that appear in these selections for the 
load, time and magnification will change.
			 
When testing with a Regular BOSS unit the operator must use “Lab 
BOSS” for the magnification and with a Small-nose BOSS the operator 
must use the “Lab Small” selection.

	8) Finally the operator has the opportunity to enter a comment.  This 
comment applies to the entire setup file and is used on reports.
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2.1.1 Create a New File - Pin Brinell Testing (Optional feature)
		
	If the operator is using the BOSS for testing 
impressions from the Pin Brinell, the DIA 
scale should be selected, then the 
conversion must be PIN for the Pin Brinell.  

	The next pop-up provides the opportunity 
to select the pin type: D, E, F, G, or H pins, 
the type of indenter, standard or Carbide 
(STD, CAR) and the configuration of the 
tester, Impact or Clamp (IMPACT, STATIC) 
and the material (STEEL or IRON).  When 
setup of the PIN‑scale is complete, 
proceed like any other scale.

2.2 Open an Existing File

1) Select Open from the File Menu.  

2) Choose the desired file to open by highlighting it from the list on the left with the mouse or by typing in the file name.

	3) Open the file by selecting the OK button or by double clicking on the file name in the list.

	NOTE:  If the file you want to open is one of the 4 files listed in the File Menu, simply click on it or press the 
corresponding number key to open it.

	NOTE:  If you open a new file with another file already open, the current file will be automatically saved and closed.

2.3 Close an Open File

	1) Select Close from the File Menu.  The file is immediately closed leaving the   program still running and on-
screen.  The operator may then select a new file or exit the program.

	NOTE: The operator cannot exit the program by double clicking in the upper left corner of the screen.  He must 
use the FILE/Exit routine



10 B.O.S.S.(R) Operation Instructions

SECTION 3:  BASIC SCREEN OPERATIONS

The buttons on the main screen are used for: 
• basic testing
• calibration and screen setup
• accessing certain user adjustable parameters
The main screen has many controls.  A brief description is as follows

NOTE: Select 2x for BOSS HD 

3.1 Screen Controls

3.1.1  Result and Tolerance Display

	Displays the current test result, any tolerances set in the main menu under 
Setup, and the test result converted to another scale (If a conversion value 
was selected).  The current test result displays green if it is within tolerances, 
yellow is within warning tolerances and red if outside of tolerances.  If no 
tolerances are setup the result is displayed in white.

3.1.2 Clear Last Button

	This selection acts the same as Data Menu Function - Clear Last Test.



11Newage Testing Instruments, Inc.

3.1.3 Measurement Displays

	These displays show the current distance between the lines in the horizontal 
and  vertical axes.  If HK, IN or MM scales are selected, only one axis is 
shown for HB or Diameter, only D is shown.

3.1.4 Reports Selection

	This function is the same as the View menu selection from the top menu.  It 
will display the currently selected reports.  (Refer to Section 4.1.)

3.1.5  Test Axis

	Between the Measure and Accept Buttons is a display of the test axis the 
program is set to measure.  If the operator encounters  impressions or 
structures that need to measured in another axis, or in a different number of 
axes, he must select the button indicated with the question mark to change 
the axis selection.  Note: it is possible to force incorrect measurements through changing the number of axes 
so be careful.  This selection changing to a new default if the operator changes scales.

3.1.6 Load and Magnification Display

	This display (at  left) shows the currently selected test values for the 
scale being used.   The operator has an opportunity to change these 
values when setting up a new file.  It is important to make any 
necessary changes through the Update Button if the operator has 
changed any parameters on the test being made prior to the beading.  
False test results can be obtained by failing to set these parameters 
correctly. 

3.1.7 Status bar  

	The bottom right corner of the screen has a menu bar that shows the current selections for:  file name, test 
scale, and test number. 

3.2 Making Measurements

The first step is to orient the grain on the test sample to the scan head.  The grain, 
if any should run from lower left to upper right.  A diagram on the screen provides 
a reminder
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3.2.1 Automatic Measuring

	The measure button always appears when the scale is selected for HB or DIA.   Press the Measure Button to 
automatically perform the measurement of the Brinell impression.  With the BOSS system, after the measuring 
indicators are displayed, if they are not properly positioned, press the right mouse 
button to clear the indicators and return to a live image.  Press the Accept Button to 
enter the reading.   The impression must fall within all four quadrants or he will not 
be able to automatically position all the measurement marks.  (See at right.)  Then 
the operator will need to use the positioning arrows near the top right of the screen.  

When the Measure 
Button is selected the 
selection marks show 
the identified edge of 
the test sample. The 
diameter is 
automatically displayed in addition to the hardness value (unless the diameter is selected in the scale selection 
as the primary scale in which case the diameter measurement appears in the measurement display and result 
display)  If the selection marks are not accurately positioned in automatic mode the operator must right click on 
the mouse to clear the selection and re-measure.  Otherwise the operator must select the Accept Button

3.2.2 Manual Measuring

	With the B.O.S.S. the linear measurement the lines can be manually 
positioned without using the Measure Button.  The operator must make a 
judgement as to the location of the edges of the impression and click the 
mouse at the top, bottom, right and left.  The impression must fall within all 
four quadrants or he will not be able to automatically position all the 
measurement marks.  (See at right.)  Then the operator will need to use the 
positioning arrows near the top right of the screen.  (See Section 3.8)

	NOTE: After the auto-measure or after the first line has been placed, the 
image of the impression is captured on the screen (no longer a live 
image). The other lines can be placed or adjustments to the 
measurement made to the captured image.  Accept the reading or click 
the right mouse button to return to the live image. Manual Selection Marks

Automatic Selection 
Marks
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3.3  Update Test Parameters
		

3.3.1 Changing Load and Magnification (under Update Button)

	The Update button at the left of the screen allows the operator to view and change selected test parameters that the 
computer uses to determine the hardness value: the load and magnification  (current selections for load and 
magnification can be seen under the UPDATE button).  

	To change the selection, click on the UPDATE button then the pull down 
selection for LOAD.  In these pull-downs the operator can click on the 
Load, Load Time, or the Magnification selections with the mouse to 
change to another option.  A list of all the possibilities for each is displayed 
in a drop-down list.

Note separate settings for Lab 
BOSS and Lab Small

Lab BOSS,
BOSS HD,
Lab Small,

and
Lab SMALL HD
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3.3.2 Verification/Changing Calibration (under Update Button)

	IMPORTANT NOTE:  Whenever the scan head part of the B.O.S.S. is swapped 
out or repaired, it must be calibrated to the computer.

1) Using the B.O.S.S. calibration block, place the scan head on the test block 
so it fits into the circular footprint provided.  This footprint helps to reduce 
scratching on the indentation which can lead to reduced calibration 
accuracy.  Orient the test head so the grain appears to be running in the 
correct direction on the monitor.  

2) Use the mouse to click on the measurement points or select the measure 
button.  

3) Compare the numbers in the measurement window on the right side of the 
screen to the actual dimensions of the test block. If they are within 0.02 mm 
the system does not need calibration. If calibration is needed, see the 
following.

4) Select the Calibrate Button under the Update button on the left of the main 
screen.  The program will then prompt for a password.

5) Key in the actual dimension. Select F1 OK when done.  The number in the 
measurement window on the right side of the screen will change to indicate 
the corrected number.

6) When finished, select F1 OK to complete the procedure.

       B.O.S.S. STYLES 
(see previous page)  

When testing in Brinell scales with 
the regular BOSS unit you must use 
the “Lab‑Boss” setting for the 
objective. With the small nose BOSS 
you must use the "Lab Small”.  These 
settings are marked on the display. 

B.O.S.S. 
Calibration Block

Calibrate Button as seen 
after pressing the 

Update Button

"Lab Small" style
without removable

base

"Lab Small" style 
with removable 

base

Standard 
USB "Lab Boss" style
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3.3.3  Adjust Camera (under Update Button)

	This allows the operator to make changes to the image in several ways.  If these settings are changed, the 
operator can re-establish the default settings by selecting the RESTORE button.

3.3.4 Selection Line Control Functions (under Update Button)

The selection lines that appear when the operator clicks on the edges of the test specimen can be changed to 
make the measurement process easier.  The Line Type selections and the Color and Width buttons adjust the 
way the measuring lines are viewed on the display.  

		 1 ) Select UPDATE from the Measuring screen. The Update Parameters dialog box will be displayed.

		 2 ) Click on COLOR to change the lines to black, dark blue, violet, light blue, orange, or magenta.

		 4 ) Click on WIDTH to change the line thickness to fine, medium, or heavy.  
		
		 5) Click on LINE TYPE selection change the line 

style to standard (short lines), long lines, Vee 
shaped, or center lines selections

		 6) Select F1 OK when done.

3.3.5  Camera Gain (under Update)

	This option adjusts the positioning of the lines.  
Adjustment is not usually necessary.  To adjust the 
operator can repeatedly press the forward and 
backward arrows under the horizontal or vertical 
scales.  This will adjust the lines wider or narrower with 
respect to the edge of the indentation..  

	If the operator wants to make a test to check the 
adjustment, he can press the Measure Button to perform a 
test.  If the gain is not set correctly he can adjust it further.

3.3.6  Camera Shift (under Update)

	This option adjusts the position of the sets of lines 
(horizontal or vertical) in relation to the edges of the 
indentation.  Changing the values moves the sets of 
lines left/right or up/down, respectively.

3.3.7  Color Camera (under Update)

	This option enables the image to be seen in color if the 
appropriate graphics card and scan head are used.

Update screen
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3.4 Full Screen Operation

When the operator selects the Full Button, he is able to see the maximum 
possible surface area of the test sample.  The test operation buttons are 
repositioned near the top to provide a better view.  The operator may also select 
to view the center area in a magnified view - either 2x (with one click) or 4x (with 
2 clicks).  Select the Done Button to continue.

3.5 Screen capture and Magnification

The Operator may choose to save an image of the test sample as it appears on the 
screen (without the BOSS controls).  If the operator selects SAVE and provides a 
name at the prompt, a bitmap (.bmp) file will be created and saved in the default root 
directory or in another location as setup in the Menu selection for Setup.

The operator may also select to view the image as a magnifiication as shown on the buttons.  If 2X is selected, he will be 
able to choose 4X. 
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SECTION 4  MENU BAR OPERATIONS 

 4.1 View Menu

4.1.1 Advanced Statistics Software (Optional)

	With this option the View Menu  consists of 7 different functions: X Bar/R Chart, Histogram,  History Data, Tile, 
Auto Tile, Tool Bar and Status Bar.  When activated, a check mark will appear in front of the function listing.

	Click on View to display the available functions.  Click on the individual functions to activate or deactivate them.

•  X Bar/R Chart - displays the X Bar/R Chart window.
•  Histogram - displays the Histogram window.
•  Tile - resizes and rearranges all open windows so that they can be seen on screen at the same time.
•  Auto Tile - automatically resizes and rearranges all 3 windows so that they can all be seen on screen at the 

same time.
•  Tool Bar & Status Bar are the same as in the standard software.
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4.2 Setup Menu

	The Setup Menu consists of 4 different functions: Average, Test  Setup, Tolerances, and Scale Select.

4.2.1 Average Menu (Optional)

	The operator may select to record averages of multiple tests rather than the individual tests.  The data file must 
be empty to enter or change an average group size.   If there are tests already in the file, the Set Average Group 
Size button will not appear activated.

	To operate the averaging function open a new file or clear all data out of an existing file.  Select the first option 
from the Setup menu - Average.     Press  the Set Average Group Size button.   An new window opens which 
allows the operator to enter a group size.
 
	After the group size is entered another menu appears.  This menu allows the operator to make four choices in 
the handling of the average

	The selections are as follows:

NONE	  - The default setting.  Returns the Average Mode to the  standard mode

Eliminate Highest and Lowest Values  -  When 3 or more tests are selected to be averaged the system 		
will remove the highest and lowest values from the group average.  For example, if the average is set for 5, then 
3 	results will go into the average.  If an average of 2 is selected  the average function has no effect.

Eliminate furthest from the average   -  Once the testing is completed the system calculates the 	average 
and removes the one test that is furthest from  that average.  If an average of 2 is selected the average  	function 
has no effect.

Eliminate the furthest from maximum standard deviation  -   The operator is prompted to enter a 
maximum standard deviation value.  When the testing is done the value farthest 	from the standard deviation 
allowable is removed.  If all the  values fall within the standard deviation then none are removed.
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4.2.2 Test Setup

	The Test Setup is used to enter the company name, a margin at the top of the page and Comments which will 
appear on the printouts.   The Network Drive Option allows the operator to  automatically copy the current data 
files to an additional location.  The data copy function occurs every time the file is closed

4.2.3 Tolerances

	The tolerance selection is for changing tolerances in an existing 
file.  Its operation is exactly the same as the initial file setup.  
(Refer to the File Open section.) 

	NOTE: Entering zero values for both will deactivate the 
Tolerance  function. All readings will then be assigned an 
“OK” status.  Also, once a file has been set up with tolerance 
settings, changing the tolerances will affect the statistical 
calculations for all the test results that have been entered to 
that point. 

The audible alarm checkbox will prompt the operator audibly 
when a test is out of tolerance.

When the Acknowledgment Required  box is checked  the 
operator will have to acknowledge every time an out-of-
tolerance result is produced. The operator can also enter the 
default error-checking value to limit the relative size of the two 
axes on the Vickers scale.

The Max Axis Difference value controls the allowable 
difference in measurement (in %) between the X and Y axis 
measurements.  For example, if the test impression is out of 
round due to testing along the side of a cylinder, the operator 
may control the maximum out of roundness that is 
acceptable.
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4.2.4 Scale Select
	This is used to select new Primary and/or 
Converted Scale designations.   The function is 
the same as was described under the "File Open" 
section

	The scale can only be changed when setting up a 
new file, or if the data has all been cleared out of 
the data file.  Once data has begun being 
collected, you cannot change the scale 
designation for the current open file.  If you 
attempt to do so, a dialog box will appear 
prompting you to close the current file.  To change 
the scale clear all data from file (See data menu.)

4.2.5 Communications Setup

	Communications Setup is used to set the parameters 
of the Serial out-put.  At the end of each test (when 
the result is accepted), the information can be sent 
through the serial port to a separate computer. The 
data string selections are Parity,  Data Bits, Data Rate 
(Baud) and Port.

	Check boxes are provided for the type of output; if 
the entire string of the history data is to be sent to 
the serial port (the same string as it appears in the 
data line) then select "Output All"; if the "Output 
Result Only" box is checked, only the actual value 
accepted is transmitted.  If "Output Off" is 
selected then no data is sent.

If the "Enable Trace" box is checked, the data 
seen at the lower left part of the toolbar in the 
main window (File name, Scale, Test number) is 
added to the test result in the serial output.  

4.2.6 Select Settings

This allows the operator to choose the Load and 
Magnification as described in new file setup
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4.3 Data Menu

	The Data Menu consists of 4 different functions: Clear Last Test, Clear Test #, Clear All Tests, Statistics, and Part 
Information.

4.3.1 Clear Last Test

	This function is used to clear the last test 
result from memory.  It is the way in which 
you can delete an erroneous reading caused 
by machine or operator error and not affect 
the statistical calculations.
	This is the same as the UNDO‑button

1) Select Clear Last Test from the Data Menu.  
A dialog box will appear asking you if you 
are sure that you want to clear the last 
test taken.

2) Select the Yes button to delete the last test.

4.3.2 Clear Test Number

	This function is used to clear any of the test 
results in the current file from memory.  

	1) Select Clear Test #  from the Data Menu.  
A dialog box will appear asking the operator 
to enter the test number.  

	2) Enter the number to be deleted.  After the 
number is entered the operator is prompted 
to verify that it is the proper number.

4.3.3 Clear All Tests

	This function is used to clear all of the test 
results in the current file from memory.  

1) Select Clear All Tests from the Data 
Menu.  A dialog box will appear asking 
you if you are sure that you want to clear 
all tests in the current file.

2) Select the Yes button to delete all tests.
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4.3.4 Statistics

	This function provides an on screen listing of statistics .  The operator can select a range of results and the statistics 
will automatically change to reflect the selected range.  "No Cpk" will eliminate this value from the reported information.  
Any selected range of data can be exported to a comma delimited .csv file.  If averaging has been implemented under 
the setup menu, the averaged values and the set of individual values (up to 5) for each average appear in the  statistics.  

4.3.5 Part Information

This function is used to enter part 
information in each file that will appear 
on the reports.

Select Part Information from the Data 
Menu.  A dialog box will appear where the 
operator can enter descriptive information.

Clicking on the checkbox for “Prompted” 
will cause this window to appear  . . . . . . .     
after each test so the operator can enter 
relevant data.  This function pertains only 
to single point testing - not traverses

To change the field descriptions press 
the Field Names button. 

	Highlight a fields with the cursor and 
type a new name.  
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Select OK to exit.  To return to the original field description select the Use Defaults‑button.  To make changes 
permanent for this file press the Change Defaults‑button.
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APPENDIX A:  TROUBLESHOOTING, REPAIRS 

FOR MANY VARIOUS FUNCTIONAL PROBLEMS

- Make certain that the screen saver is turned off.  Turn off screen saver and reboot system to correct problems.  
(Depending on the exact nature of screen saver, a wide variety of specific problems can results)

NO PICTURE OR POOR CLARITY (B.O.S.S. UNIT)

- Make certain that system components are plugged in, properly connected and turned on.
- Hold the scan head without moving during measurement
- Check all fuses and connections on each of the different components.
- If there is a pink screen, try a different number of colors, 256, 16 bit, 24 bit, etc.
- Directx 8.1 must be installed

INACCURATE TEST RESULTS ON TEST BLOCK

- Perform a calibration to the electronics.  This must be done whenever a test head is returned from repair or when 
installing a loaner scan head.

PROGRAM WILL NOT PROCEED

-Make certain that system components are plugged in, properly connected and turned on.

CHECKS TO MAKE BEFORE CALLING THE FACTORY

If you run into problems:
	1) Reboot the computer
	2) Check the calibration of the scan head to the computer
	3) Consult the Windows Manual for troubleshooting information
	4) Contact Newage Testing Instruments, Inc. Technical Customer Service at: Tel: 215-355-6900;  Fax: 215-354-1803

REPAIRS AND SHIPPING INSTRUCTIONS

If your system or just the B.O.S.S. scan head needs repairs, it must be packed in a sturdy box using bubble wrap or 
equivalent for padding.  It is important that the components be well protected from damage and that the box be 
doubleweight or double boxed to prevent penetration during shipping.  Include a statement of the desired service or a 
description of the nature of the problem with the unit.  Address the package to Service Department.  The package should 
be insured for the value of the instrument.  Newage will call with an estimate for repairs.  Note our address information 
changed in 1/2000:
      

Newage Testing Instruments, 
820 Pennsylvania Blvd., Feasterville PA 19053, USA

If the scan head alone is returned to us we are unable to provide a calibration but will provide a certificate of operation.  This is 
because the scan head must be calibrated in conjunction with the computer it is to be used with.  After a test head is 
returned or when a loaner unit is used, it must be first calibrated with the computer prior to use.
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APPENDIX B: FILE LAYOUT

filefmt.doc

FILE FORMAT, Version 2.0

Line 1:

char FileSignature Version [14];
char Comma;
char RecordCount[5];        // count of records in the file
char Comma;
char RecordLength[3];       // length of fixed-length records
char Comma;
char ExtraHeaderLength[3];  // length of additional header written
char    Comma;
char    AvgCnt[2];
char    Comma;
char    ConvertScale[5];
char    Comma;
char    LoadTime[2];
char    Comma;
char    Flags[5]

// Report view mode
char    Comma;
char    Header2Len[3]

// length of header2
char    Comma;
char    ExtraFieldDefLen[3];
char    Comma;
char    MaxStdDev[7];
char    Comma;
char    Objective[5];       // objective 10x... 100x
char    Comma;
char    Load[7];            // Load in grams or kg.
char    Comma;
char    Ball[4];            // Ball diameter or PIN type
char    CrLf1[2];

Line 2:

char    Scale[5];
char	 Comma;
char    Label1[7];          // "LO:"
char	 Comma;
char    LoTol[7];
char	 Comma;
char    Label2[7];          // "LW:"
char	 Comma;

char    LoWarn[7];
char	 Comma;
char    Label3[7];          // "HW:"
char	 Comma;
char    HiWarn[7];
char	 Comma;
char    Label4[7];          // "HI:"
char	 Comma;
char    HiTol[7];
char    CrLf2[2];

Line 3:

char    FileComment/Work Order[80];	
char    CrLf3[2];

Lines 4 - 13:

char	 FieldName[15];
char	 Comma;
char	 FieldInfo[20];
char	 CrLf2[2];

Line 14:

** Data **  // header line

Lines 15+:

char 	 SeqNum[6];
char 	 Comma;
char	 Date[10]; // "mm/dd/yy"
char	 Comma;
char	 Time[7]; // "hh:mm"
char	 Comma;
char 	 ConvertValue[7];// eg. Dia for HB or HRC for HV
char	 Comma;
char	 Value[7];  // Average if in average mode

If the test is an average mode test then the following 
additional fields are on each line.

char	 Comma;
char	 Min[7];
char	 Comma;
char	 Max[7];
char	 Comma;
char	 StdDev[7];
char	 Comma;    // will be n comma value pairs
char	 IndividualValues[7];// separated by commas
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APPENDIX C: B.O.S.S. TETHER OPTION 

Read the tether manufacturer directions to set up the tether.
To install the BOSS scan head on the tether, unscrew the nut holding the cable to the scan head.  Attach the clip from the 
cable over the cord between the scan head and the nut (See photo #1 below).  Push the clip up against the scan head 
and reattach the nut to full tightness (See photo #2 below).

Attach the tether coil clip to the tether arm.  Follow manufacturer directions for any tether adjustments.

Other tether options are available as well

 

Model appearance may differ than shown
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APPENDIX W: LIMITED WARRANTY

ONE YEAR LIMITED WARRANTY

Should Newage Testing Instruments, Inc. equipment require service, we will repair or replace, at our option, any part or 
product which upon examination by a NewAge Industries service technician, shows to be defective in material or 
workmanship. 

This warranty is extended to the original purchaser only, for a period of one year (12 months) from owners date of 
purchase. Excluded from this warranty are any parts that are to be replaced as part of normal product operation, 
such as but not limited to indenters, test blocks, 
indenter shrouds, and Etching Pen writing points.

This warranty IS NOT VALID IF THE INSTRUMENT HAS BEEN MODIFIED,  MISUSED OR DAMAGED in any way, except 
by a factory-authorized Newage Testing Instruments representative.  Where required, products should be set up and 
training provided by a factory-authorized representative.  Damage  caused by improper set up, disassembly, or service by 
any person other than an authorized Newage Testing Instruments’ service technician is not covered under this warranty.

Please read the operation manual supplied with the instrument prior to operation.  This warranty applies only to 
instruments sold by Newage Testing Instruments, Inc. and its authorized distributors.

Newage Testing Instruments, Inc. is not responsible in any way for losses, damage, or other forms of consequential 
damage resulting from equipment failure 
or improper use. 

IMPORTANT: Register your instrument with the Newage Testing Instruments, Inc. service department by filling out and 
returning the enclosed warranty registration card.
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